
	User guidance
The standard form following is for the preparation of a tender document for Consultancy Services: Multiple Tenders
Part 2: Tender Schedules
Guide notes
This standard form contains guidance in hidden text, ie:
GUIDE NOTES;
Guide Note examples
Viewing guide notes
1. If the guide notes are not visible, click on the Show/Hide button [image: image1.bmp].
2. If still not visible, then:

•  At the Tools menu;

•  Click Options, and click the View tab;
•  Tick the Hidden Text check box and click the OK button.
Insertion points
Each ‘»’ shows where input is required. Click onto each ‘»’ and overtype.
When completed
1. Remove all guide notes manually or by the following steps:
•  On the Edit menu click Replace, then (if required) 
•  Click the More button;
•  Click the Format button, click on Font;
•  Tick the Hidden check box and click the OK button;
•  Click the Special button, click on Any Character; then
•  Click the Replace All button.
2. Delete this User guidance, along with the following Page Break.
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Tender Schedules

Complete the details for each Tender Schedule to be used.  

Delete Schedules not used, eg only one “fee” schedule to be used. 

Make sure that each Tender Schedule has the name of the engagement in the Footer.

ADDITIONAL RETURNABLE SCHEDULES MAY BE includED TO SATISFY PARTICULAR NEEDS. 

when the tender document is issued in hard copy Provide one set of schedules loose for submission by Tenderers.

Use option 1 FOR A TENDER NOT USING THE TWO-ENVELOPE SYSTEM

USE option 2 FOR A TENDER USING THE TWO-ENVELOPE SYSTEM

option 1 

The following Tender Schedules must be completed and submitted as part of the tender:

· Tender Forum – Non-Price

· Tender Form – Price
list each Tender Schedule by heading

· »

end of option 1

option 2

The following Tender Schedules must be completed and submitted as part of the tender:

Envelope 1 (Non-Price Schedules)

· Tender Form – Non Price
list each Non-Price Tender Schedule by heading

· »

Envelope 2 (Price Schedules)

list each Price Tender Schedule by heading

· »

end of option 2

Tender Form – Non-Price

 (SUBMIT IN ENVELOPE 1 – NO PRICE DETAILS)

Tender Closing Office

	Name:
	

	Address:
	

	Facsimile number:
	


Tenderer’s details

	Name:
(in block letters)
	………………………………………………………….…………

……………………………………………………….……………

ABN ...………………….…………………………….….……….

	
	

	Address:
	……………………………………………………….……………

………………………………………………………….…………

	
	

	Telephone number:
	……………………………………………………………….……

	Facsimile number:
	……………………………………………………….……………

	e-mail address:
	………………………………………………………….…………

	
	

	
	hereby tender(s) to perform the services for


Tender details

	Agreement name:
	

	Contract number:
	

	
	

	
	

	
	


Tender Form - Price
delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

Tender Closing Office

	Name:
	

	Address:
	Street Address: 
Mailing Address: 

	Facsimile number:
	


Tenderer’s details

	Name:
(in block letters)
	………………………………………………………….…………

……………………………………………………….……………

ABN ...………………….…………………………….….……….

	
	

	Address:
	……………………………………………………….……………

………………………………………………………….…………

	
	

	Telephone number:
	……………………………………………………………….……

	Facsimile number:
	……………………………………………………….……………

	e-mail address:
	………………………………………………………….…………

	
	

	
	hereby tender(s) to perform the services for


Tender details

Ensure that the details match the agreement name and number used on the title page.

	Agreement name:
	» 

	Contract number:
	»

	
	in accordance with the following documents:


Where applicable, List all Tender Documents by Volume, for Example:

Tender Document Volume 1 – Specification

Tender Document Volume 2 - Drawings

Amend the following list to ensure that the Volume names and numbers correspond with the Table of Contents

	
	Tender Document »

	
	»

	
	and Addenda Numbers: …………………………………….……


use Option 1 or 2 and delete the option not used.

· Use Option 1 when the fee will be a lump sum.

· Use Option 2 when a schedule of rates will be used.

Option 1

	For the Fee, being the lump sum of:

	…………………………………………………………………………………………….

	…………………………………………………………………………………………….

	($……………………………………………) including GST.


End of Option 1

Option 2

	For the Fee, being the sum of:

	1. any Lump Sum in the attached Schedule of Rates;

	2. the products of the estimated quantity and the relevant rate for each item in the attached Schedule of Rates;

	up to the maximum amount of:

	…………………………………………………………………………………………….

	…………………………………………………………………………………………….

	($……………………………………………) including GST.


End of Option 2

Schedule of Prices - Lump Sum

(SUBMIT WITH TENDER FORM)

Include when dissection of the tendered lump sum is required, otherwise delete.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

Insert the amount allowed for each of the following items.

This Schedule is for information only and does not form part of the Agreement.  Its purpose is to assist in making valuations of services carried out but the Principal is not bound to use it.

All amounts must include an amount for GST.

	Item
No.
	
Description
	
Amount

	1
	Break-up of Lump Sum tendered:
	

	1.1
	»
	$ ………….….


list the specified deliverables , for example:

Schematic Design

Design Development

Documentation

Expand the table by inserting rows, as required.

	
	
Total of tendered Lump Sums
	
$ ………….….


End of Tender Schedule - Schedule of Prices - Lump Sum.

Schedule of Rates

(SUBMIT WITH TENDER FORM)

May be used for an engagement using hourly rates only or in combination with deliverables and lump sums.

otherwise delete.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

Complete the item number, description and quantity for all items.

FOR LUMP SUM ITEMS: Insert “1” at quantity, “ITEM” AT UNIT and “LUMP SUM” AT RATE (as shown).

FOR RATE ITEMS: insert the applicable quantity range at the description and INSERT ESTIMATED quantity AND UNIT. 

Complete this Schedule by inserting the tendered rates under Rate, or where Lump Sum appears by inserting the tendered lump sum under Amount.  Where a rate is tendered, insert under Amount the amount arrived at by multiplying the tendered rate by the quantity.

The rates and lump sums tendered shall form part of the Agreement.  The correct extended amounts and total shall be used to assess tenders. The correct total shall be the maximum amount of the Fee.

All rates and lump sums tendered must include GST.

	Item
No.
	
Description
	
Quantity
	
Unit
	
Rate
	
Amount


Item 1 is Mandatory.

	1
	All services and obligations under the Agreement NOT INCLUDED ELSEWHERE in this Schedule.
	

1
	

Item
	
Lump Sum
	

$ ……...

	2
	Rate items:
	
	
	
	

	2.1
	»
	»»
	»
	$ ……….
	$ ……...


	3
	Lump Sum items:
	
	
	
	

	3.1
	»
	»
	Item
	Lump Sum
	$ ……...


	
	
Total of Schedule of Rates (maximum amount of Fee)
	
$ ……...


End of Tender Schedule - Schedule of Rates.

Hourly Rates for Variations

Include this tender schedule if hourly rates for variations are required for the engagement, Otherwise delete

if the schedule is used, address evaluation of rates in the tender evaluation plan

Insert the job titles of the roles for which rates are sought.  Add or delete rows as required.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

	Role
	Name
	Hourly rate

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


End of Tender Schedule - Schedule of Hourly Rates for Variations

Agreement Information items

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

2
The Consultant

	The Consultant is:
	……………………………………………...

ABN ..……………………………………...


7
Consultant's Representative

	The Consultant's Representative is:
	……………………………………………...


17
Notices

Notices to the Consultant

For notices to the Consultant the intended recipient is the Consultant’s Representative:

	Office address:
(for delivery by hand)
	…………………………………………..

…………………………………………..

…………………………………………..

	
	

	Postal address:
(for delivery by post)
	…………………………………………..

…………………………………………..

…………………………………………..

	
	

	Facsimile number
	…………………………………………...

	E-mail address
	…………………………………………...


Outline Services Delivery Plan

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Prepare an Outline Services Delivery Plan for the Services.  The Outline Services Delivery Plan will be taken into account when assessing the Proposal.  The Services Delivery Plan must be developed within the time specified in Item 4 of the Agreement Information.

The Outline Services Delivery Plan must include, as a minimum:

1. An outline program for the Services showing key activities, the time allowed for each key activity, and milestones or points at which reviews of the work are planned.

2. Key personnel proposed to perform the Services (including sub-consultants).

3. The project roles, responsibilities and authorities of these key personnel.

4. An outline of design reviews, verification methods, any internal reviews and Principal reviews proposed.

5. An outline of the expected inputs to be supplied by the Principal.

6. Proposed deliverables to satisfy the Conditions of Agreement, for each phase of the Services.

7. Information on the proposed Consultant’s and proposed sub-consultants’ key personnel, including:

· name and title;

· role in performing the Services;

· qualifications and recent relevant experience; and

· expected timing and duration of involvement in the Services.

8. Method of evaluation, review and management of sub-consultants.

9. Services organisation chart (showing major interfaces) for the key personnel.

10. Procedures, checklists and office standards proposed for the engagement.

11. Relevant regulatory requirements peculiar to the engagement, including building codes, standards, regulations and design codes.

12. The activities to be completed for each phase of the work, provision for their sign-off, and clear references to the associated records that will be produced, including and design/detailing elements that are proposed for completion after letting the contract(s) and the design work assumed to be completed by the contractor(s).

13. Fee component for each key activity and phase of work (adding items to the break-up on the Fee tender form as required).

Where the submission of competitive tenders is subject to the "two envelope" system, the above bullet point must be deleted and the information sought by the appropriate Tender Schedule for the Fee so that pricing and non-pricing data may be kept separate by the Tenderer.

14. Description of design/quality, environmental and safety management proposed.

Schedule of Quality Management System information

Include this Tender Schedule when design or design management is involved in the services.

Otherwise delete

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Current status of quality management system

	Does the Tenderer have a third party certified quality management system to AS/NZS ISO Standard 9001:2000?
	· Yes, or 
· No


If “Yes”:

	· Name of certifying third party:
	………………………………………………

	· Date of last internal audit:
	………………………………………………

	· Date of last external audit:
	………………………………………………


· Attach a copy of the internal audit log.

End of Tender Schedule - Schedule of Quality Management System information

Schedule of Mandatory Alternative Tenders

Include this form only when mandatory alternative tenders are requested, as specified in the section Alternative Tenders.

Otherwise delete.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

List the alternative Tenders required in the column Mandatory Alternative Tenders.  Add and delete rows as required.

Enter the additional amount allowed for each of the following mandatory alternative items.  

	Mandatory Alternative Tender Items
	Amount

	
	$

	
	$

	
	$

	
	$


End of Tender Schedule - Schedule of Mandatory Alternative Tenders

Insert the Name of project and/or contract and theContract No.

The details must match those on the title page

	
	

	»

Contract No: »
	Page 1


Consultancy Services: Fee over $30,000

Insert the Name of project and/or contract and theContract No.

The details must match those on the title page

	
	

	»

Contract No: »
	Page ii


Consultancy Services: Multiple Tenders


